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About Material Receipts

The Resident Engineer (RE) office is responsible for documenting the receipt of
materials on the project site. Some materials are received by completing a Report of
Material Received M&T Form 251 (MRR) and some are received by creating Ticket
Books. Supporting documents, such as Certifications, Invoices, and Alternate ID lists,
are attached to the MRR.

NOTE: All Materials and supporting documentation must be received
onto the Project. Some materials will not be entered in HICAMS. The
supporting documentation and tickets for Materials which are not
entered in HICAMS should be maintained in a folder in the project
records with a notation similar to "Not received in HICAMS".

To determine how the Materials are to be received, consult the Minimum Sampling
Guide (MSG) found under References > Minimum Sampling Guide. The How
Received code will be either Material Receipt, Ticket, or Not Received.

NOTE: This information is also contained on the Standard Report
"Contract Bill of Materials Report" in the column labeled How Received.

To receive Materials in HICAMS, the Material must be present on the Contract Bill
of Materials for that Contract.

When a Material Receipt record is inserted on a project in HICAMS, information about
how the material is accepted also defaults from the MSG. The MSG controls whether
Certification data or Alternate IDs need to be entered on the MRR record in order for the
Accepted Quantity to update.

NOTE: The Material Received quantity should always equal or exceed the
amount of Material that has been Paid for on a Project.

Additional Information about receiving specific materials can be found on the HICAMS
home page in the FAQ section. To access the HICAMS home page, go to Help >
HICAMS Homepage.
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Entering A Material Receipt

Material Receipts can be entered two ways, either by Inserting a new record, or by
performing a Save As to an existing record.

To work with the Review Material Receipts window, go to Functions > Contract
Tracking > Review Material Receipts.

Inserting a New Record

Step 1.

Step 2:

Step 3:

Enter the Contract Number whose Material Receipts you wish to enter in the
Contract field.

Note: For information on ways to enter your contract number, see
the User Guide "Getting Started" in the User Guides section of the
HICAMS home page.

Select the Line Item for which you are entering the Material Receipt either by
typing in the Line Item number in the small field to the right of the words "Line
Item" or by selecting it from the drop down list. Any existing Material Receipts
for that Line Item Material will display in the grid.

Click the Insert button [*8 (or Insert key) and a new row will be entered. The
new row is inserted at the top of the existing rows and becomes Row 1. The
Date defaults to the current date. The Line ltem defaults based on the Line
Item originally selected, and Received By defaults to the name of whomever
is logged in.

# HICAMS - [hicamsval] ==
File Edit Functions Inguiries References  Admin Tools  Window Help

|=ma|a a2 b 84

Step 4:

4w Review Material Receipts (C201439) M=l E3
Contract: W @ Contractor: TRIANGLE GRADING & PAVING, INC Status: Active
Description (nickname): NC 98 (Holloway Street) Widening
Line Item: |12— TV UOM: Linear Feet
Received Plant
Row MRR Material UOM Quantity Received By 1D
_ 0 Reinforced Concrete Pipe Cubvert m Arrnstrong, ._IamEE: ] |
2 Reinforced Concrete Pipe Culvert LE | 400000 Armstrong, James  [CP10
3 06152008 12 Reinfarced Concrete Pipe Culvert LE | 32000 Ammstrong, James  [CP10
4 07/30/2008 12 Reinfarced Concrete Pipe Culvert LE | 5312000 Armstrong, James  [CP10
5 11/05/2007 12 Reinfarced Concrete Pipe Culvert LE | 162.000 Amstrong, James ~ [CP10
6 10/17/2007 12 Reinforced Cancrete Pipe CubvertLE | 352000 Amstrong, James  [CP10
7 10/08/2007 12 Reinforced Goncrete Pipe CubvertLE | 260000 Amstrong, James  [CP10

Enter the MRR number and change the date to match the date on the original
Material Receipt form if necessary.
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Step 5: If there is only one Material on the Contract Bill of Materials for the Line Item
selected, it will default in the Material column. If there is more than one
Material on the CBOM for the Line Items, select the Material you are receiving
from the drop down list in the column Material. The Materials on the list are
the same ones that appear on the Contract Bill of Material for the designated
Line Item. The Unit of measure will default based on the Material selected.

#»Review Material Receipts ((201562) M= E3 I
Contract: |CQD1 962 @ Contractor: BALFOUR BEATTY CONSTRUCTION NC  Status: Activated
Description (nickname): Bridge - Stadium Drive - ‘Wake Forest

Line Item: |9 |MASNRY DRAINAGE STRUCT LI UOM: Each

Line Received Plant
Item Material Jyom Quantity Received By 1D Status |

0 0.000[Movello, Marie B [EE) Recefved .l.
2 B | 50472006 B |concrete, Class B- CY

|2 |D4f28f2006 |9 Precast Concrete Units - EA
Reinforcing Steel, Flain, For Miscellaneous Use - LB

1| | 3

Note: If the Material you need is not present on the drop down list, you
must add it to the Contract Bill of Materials to make it available.

Step 6: Enter the Received Quantity, and update the Received By field, if necessary.
In general, the name in the Received By field is the person who created the
paper Material Receipt, not the person doing the data entry. Use the staff
selection button to select a different name.

Step 7: Some Materials such as Concrete, Frames and Grates, and Structural Steel
require a Plant ID. If you know the producer's Plant ID, it can be typed in the
Plant ID field. If not it will be selected on the General Tab.
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Step 8: To determine what other information is required, consult the Minimum
Sampling Guide for this Material Type or Save the record. An error message
similar to the following may appear:

s Message Log

Meszages 1

Flease provide the fallowing required infarmation for M aterial Feceipts:
Fow 1:

An dpproved Producer name must be entered based on the M5G Facility Type for this b aterial.
A, Concrete Miw must be entered bazed on the MSGE Approved Plant Type for thiz Matenal.

Print

Step 9: To enter the Approved Producer/Supplier, click on the Factory Icon k===l on
the General Tab. If an Approved Producer/Supplier is required, the
Producer/Supplier selection box opens with the Facility Type set to the
required Facility Type, in this case, Ready-Mixed Concrete. The list is
automatically filtered for only that Facility Type which is required by the
Minimum Sampling Guide.

## Producer /Supplier

Filter
PruducerfSuppIier:| Retrieve

Facility Type: Ready-Mix Concrete

Plant ID:
Producer/Supplier Facility Name Plant ID Facility Type _i‘
A, J. Woton Drymix Foam Conc. Plant #18 A, J.woton Drymix Foam Conc. Plant #18 Rh1432 ady % C E
A J. %oton, Inc., LLC A J. Woton, Inc., LLC Rh4410 Ready-Mix Concrete 1

Allen/Godwin Concrete Inc. Barrus Ready Mix Concrete - Castle Hayne RM270 Ready-Mix Concrete O
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Step 10:

Note: Remember that although all active Ready Mix plants appear
in the search window, Concrete Mix Designs are assigned on a
Project by Project basis. The mix designs must be submitted to the
Physical lab at M&T for approval prior to their usage on a project.
To see what Concrete Mix Designs are assigned to a contract, go
to References > Concrete Mix Designs > Assign Contracts and
enter your contract number. The Ready Mix plants on this list are
the ones that can be used for this contract.

Note: If the Facility Type defaults to ALL (see below), the producer
of the material does not need to be an Approved Producer/Supplier.
The name of the producer/supplier should be typed in the Other
Producer Supplier field.

& producer/Supplier
e PruducerfSupplier:I
Facility Type:|(A||) |
Planti:[

If the Material requires Certification information, complete the Certification
Tab.

General  Cert mé'AItema{elD |H\st0ry|

Certifications: [7: Contractor's Certification | ©maT @®RE ZBoth
‘3' NManufacturer's Cerification | OMET ®RE D Both
[Nane) | ©mar CORE  OBoth

Approved Date: [02/24/2008 @|

Approved By: }Armstrong, James G

| %

v Documents Received

|Ready

Confirm that the certification is of the correct type. Enter the Date the Inspector
approved the certification, check the Documents Received checkbox, and select the

Inspector who approved the certification from the Staff List.
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Step 11:  If the Material requires that an Alternate ID be entered, complete the Alternate
ID Tab.

|
General | Cerfification  Alternate 1D |History |

Alternate Received Accepted Sample | FIR Report FIR Report
Row Alternate ID Quantity Quantity 1D Type 1D Count|? =
e[ oo oog [ Py | =
Create Range |

Define Range

Clear Range |

|Ready

A row for the first Alternate ID should have been entered by HICAMS. If not, click
the Insert button in the tool bar. Notice that the Producer/Supplier plant ID
defaults into the Alternate ID field.

Select the Alternate ID type from the drop down list.

General | Cetification  Alternate ID |Hist0ry |

Alternate Recei
Row Type Alternate ID Quan

|Ready

Note: If you are unsure what Alternate ID type to select for your
material, please contact the M&T HICAMS support staff at 1-919-
329-HELP (4357).

Enter the Received Quantity and Save the record. The total of the Received
Quantities for all Alternate IDs must be less than or equal to the Received
Quantity for the Material. If the Alternate ID is associated to a Sample or a Field
Inspection Report (FIR) and there is a quantity still available on it, the Accepted
Quantity will update, and the Sample or FIR number will be populated when the
record is Saved.

Note: If a number of Alternate IDs that are in a sequence need to
be entered, use the Create Range functionality, the same as in the
Enter Samples window.
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To use this functionality, enter the first Alternate ID and Save. Then
update the Count field to be the total number of Alternate IDs in the
sequence that are needed. Click Create Range and 10 Alternate
IDs will be inserted.

For example, if the Alternate IDs that need to be entered are PC-
090308-1 through PC-090308-10, enter the first Alternate ID ending
in 1 and Save. Next set the Count to 10, then Create Range. A total
of 10 Alternate IDs will now appear on the Alternate ID tab.

Step 12:  After all required information has been entered, Save the record. A green

check mark v/ should appear in the far right column. If any of the required
information is not entered, an error message will appear that references the

row number and the missing information and a red X X will appear on the
unsaved row. Entering the requested information should allow the record to
be saved.

Entering an MRR using the Save As Button

The Insert button L8] creates a single row in the grid. It can be used repeatedly, and
then the data filled into multiple rows before a Save. Tabbing is an effective way to
navigate in the rows.

The Save As button 2| makes a copy of the selected row minus the quantity, including
the date and Received By Inspector. Processed, Not Estimated, and Void Records can
be Save As'd.

Save As can also be used to create multiple rows before the data entry is done. You
may want to do your first Save As and update the date, then create your additional rows
from that record as it will then carry the new date forward with it. This allows the Tab
key to be used to navigate through the data entry fields.

Note: If the Conversion Factor has been changed on the CBOM, an
Insert record will have the new (current) conversion factor. A Save As
record will have the Conversion Factor of the original record.
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Changing Existing Records

Changing the Line Item or Material entered

If the record has already been saved, and you discover an error in the Line Item
number, the Material, or the quantity, simply change that information and Save again.

HICAMS will once again perform the data entry checks and alert you to any missing
information which must be entered in order for the record to be saved.

Note: It is sometimes possible to eliminate errors by closing the window
and answering No when the system asks if you wish to Save changes.
This removes all data entered since the last Save occurred and restores
Alternate IDs removed in error.

Review Material Receipts (C201562) E |

@ Do wou wish to save changes?

Mo | Cancel |

Deleting Or Voiding an Existing Record or Alternate ID

If the record was entered in error, and it has not been Saved, hit the Delete button (in
the toolbar) and it will be removed. Once the record has been Saved, use the Void
button (in the toolbar) to remove the effect of the entered record.

Step 1:

Step 2:
Step 3:

Step 4:

Step 5:
Step 6:

Select the record entered in error.

Click the Delete button 2 . If the delete button is not available, go to Step 5.

When the "Are you sure you want to Delete?" Message opens, click Yes if
you want to delete the record.

Review Material Receipts |

@ Are you sure you wank ko delete?

If the record has already been Saved, the Delete button will not appear. The
Void button will appear instead.

Click on the Void button [#
The Void Comment box opens.
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& ¥oid Comment |

“ou are about to Yoid a record. A record once voided cannot
be updated. All changes will be saved after Void.

Password:

Comment:

[0]4 Cancel

Step 7: Enter your HICAMS password in the Password field and type a comment in
the Comment field. The comment should provide enough information that the
reason the record was voided is self explanatory. A comment such as
"Entered on the wrong Contract” is better than simply stating "Error"

Step 8: Click OK. The MRR record status will be changed to Void, and the Received
Quantities removed from the Project Certification calculations.

Note: The Delete icon will appear when the Alternate ID tab is open, even
after the MRR has been Saved. The only thing that can be deleted at that
time is the Alternate ID rows. If you wish to negate the entry of the
Material Receipt, VOID the record instead.
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Transferring Materials

Materials can be transferred from one construction project to another, and in HICAMS.
When Material is transferred, information about the acceptability of the Material goes
with it. In fact, the point of doing a Material Transfer — as opposed to an “unreceipt” on
the source project and a receipt on destination project — is that the determination of
acceptability does not have to be done again (although the destination project will
frequently choose to take its own Project Acceptance samples).

Transfers are initiated when the Contractor asks the Resident Engineer (RE) on the
project which has the Material (the source project) if it can be transferred to another
destination, typically another DOT project (the destination project). The RE identifies the
appropriate Material Receipt, which is linked to acceptability information. The
destination project information and quantity of Material to be transferred are entered in
HICAMS. If the system indicates that the desired quantity of Material is available for
transfer and the destination is another DOT project, a notification is sent to the Resident
Engineer and Project Engineer for the destination project to alert him/her of the transfer,
and a skeleton MRR record is created for the destination project. The skeleton MRR
record will be linked to the acceptance information on the originating project. When the
Material arrives at the destination project, the Material is received through the Material
Receipt process by updating the skeleton MRR record which was created by the
Material Transfer.

The RE Office initiating a Materials Transfer will also have the option to enter a
destination of “Other”. This feature allows materials to be transferred to other projects
besides those administered through HICAMS. Additionally, if material is stolen or
removed from the source project site, a “transfer” to “Other” can be used to decrement
the source project’s quantity of Material Received to keep it consistent with the physical
material on hand.

Note: If a Metric material is being transferred to an English project, the
skeleton MRR for the destination project will reflect the equivalent
Material, with the appropriate converted quantity.

In order to perform this transfer, certain conditions must be met.
1. The Material must be on the other Contract's Contract Bill of Materials.

2. The quantity transferred cannot exceed the calculated quantity of Material Paid to
date.

3. The quantity transferred cannot exceed the quantity received on an individual MRR.
Multiple MRRs for the same Material can be transferred.

4. Materials with an outstanding Material Prepayment balance on the current Contract
Estimate for the select MRR Material and Line Items cannot be transferred if the
Prepayment balance has not been reduced to zero.
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Creating a Materials Transfer
Step 1:  Select the Material Receipt which contains the Material to be transferred.

Note: Alternate IDs on the Material being transferred should match
the alternate IDs on the MRR selected.

Step 2: Click on the Transfer button La

Note: The Transfer button is only available for rows which have
been previously Saved.

The Transfer window opens.

4 Transfer Material

Y'ou are about to transfer a material. The transfer will be
performed immediately upon validation of the transfer
information and choosing the OK button.

Contract: | @
Transfer Date: IDﬁfSUQDDE @l
Quantity: | 0.0o0

Other Destination: |

OK Cancel |

Step 3:  Enter the Contract number of the destination project.
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Possible Error:

If the Contract Bill of Materials for the destination project does not have
the Material selected assigned to one of its Line Items, the following error
message will appear:

#s+Review Material Receipts {C201562) O] x|
Contract: ICQD‘I 362 @ Contractor: BALFOUR BEATTY COMSTRUCTION INC Status: Activated
Description (hickname): Bridge - Stadium Drive - Wake Forest

Line Item: |27 |HP12x33 PILES v| UOM: Linear Feet

Line Received | Plant
Row MRR Date P E— E D Status

*You are about to transfer a material. The transfer will be
performed immediately upon validation of the transfer
information and choosing the OK button.

Contract: IW @
@ The selected Contract does not contain 'HP 12 % 53 Steel Piles',
Please select a different Contract.
Othe
General | Cerfification | Alternate
Line It pe: $100.0000
Bid Quar OK Cancel 2d: [00/00/0000 @l
Approved Producer/Supp rix:

If this occurs, confirm that the Contract entered is the destination project.

If the Contract number is correct, contact the Resident Engineer's office to whom the
Contract is assigned and ask that the material in question be added to the Contract Bill
of Materials for the appropriate Line Item. Then create the Materials Transfer.

Step 4: If the date on the Materials Transfer is not today's, enter the correct date.
Step 5: Enter the Quantity to be transferred. Click OK.
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Possible Error:

If the Quantity you entered is greater than the MRR quantity, the following

message will appear:

#r+ Review Material Receipts (C201562)
Contract: ICQD1562 @ Contractor: BALFOUR BEATTY CONSTRUCTICON IMC Status: Activated
Description (nickname): Eridge - Stadium Drive - Wake Forest

Line Item: |2? |HF'12><53 FILES v| UOM: Linear Feet

I [=]

Line Received
Row MRR Date Item Material UomM Quantity Received By

Plant
1D Status ||

e: $100.0000

d IDDIDDIDDDD @l

1X:

[] small Quantity

“+ Transfer Material x|
You are about to transfer a material. The transfer will be
performed immediately upon validation of the transfer
information and choosing the OK button.
Contract: [C200725 (1]
Transfer Date: lm @I
General | Cerification | Alternate Quantity: Im
Line It Other Destination: [
Bid Quan Transfer Material
Approved Producer/Suppl Q The Transfer Quantity cannat be greater than the Material's Received Quantity of 550,000,
Other Producer/Supp!
Brand Na
How A pi
Comment: @I

ol

|Mo Matifications - This server is not monitaring for notifications,

Click OK to close the error message and change the quantity so that it is less than or

equal to the Received Quantity on the MRR selected.
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Possible Error:

If the quantity you entered is greater than the MRR Received Quantity
minus the amount Paid to Date (includes any amount with a status of Paid
or In Process), the following message will appear:

“r+Review Material Receipts (C201562) _ O =
Contract: ICQD1562 @ Contractor: BALFOUR BEATTY CONSTRUCTION [NC Status: Activated
Description {hickname): Bridge - Stadium Drive - Wake Forest
Line Item: |27 |HP12x33 PILES v| UOM: Linear Feet
Line Received Plant
Row MRR Date Item Material Jyom Quantity Received By 1D Status
05/11/2006 |27 | ¥ 53 Steel Piles 550.000[Bennett, Ransom [B=Y|3516 .I.

*You are about to transfer a material. The transfer will be

performed immediately upon validation of the transfer

information and choosing the OK button.
Contract: [C200725 |

Transfer Date: IDSISHQDDS @I
Quantity: | 550.000
General | Cerification | Alternate IC
Other Destination: [
Line Ite : $100.0000
B o000 (g
A Material that has theoretically been paid for cannat: be transferred. 5
Approved Producer/Supplit o The Estimated paid quantity of 600,000 on C201562 far the
- current Line Item and Material combination exceeds the calculated .
Other Producer/Suppli tokal remaining Received Cuantity of 0,000, l:l Small Quantity
Brand Nam Flease redure the Transfer Quantity, @I
How Accepted: Certifics sferred From:

Comment:l_ @I

|Ready

In this case, a Pay Record in the amount of 600.00 LF of Steel Piles is In Process on an
estimate. The Material Quantity is calculated by taking the Pay Record quantity and
multiplying it by the conversion factor. In this case, 600.00 LF Paid times conversion
factor of one equals 600.00 LF of material needed. If 600 LF of Piles were transferred
there would be none remaining as received for this contract.

Either the Materials Transfer needs to not be done, or the Pay Record needs to be
Voided, or additional Materials need to be Received.
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Possible Error:
If any Material Prepayment exists for this Material and Line Item

combination and it has an outstanding Material Prepayment balance on
the current Estimate greater than 0.00, the Material cannot be transferred.

Transfer Material |

balance For the Line Ikem and Material on the current Makerial Receipt.
The Prepayment balance musk be reduced ko zero before the Transfer
can be completed.

Q The current Estimate for C201562 has an oukstanding Prepayment

Multiple Material Prepayments can be entered for the same Line Item and Material
combination. At this time, there is no linkage between the Material Prepayment and the
Pay Record and the Material Receipt. The Material can be physically transferred but
cannot be transferred in HICAMS until the MPP balance is zero.
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The Skeleton Material Receipt Record

This is an example of what the system generated Material Receipt skeleton record looks
like:

##% HICAMS - [train] | _ 5]
File Edit Functions Inguiries References Admin  Tools Window Help

H e s M D & ?ﬂ /! Bﬂﬂ Training Environment
4 Review Material Receipts {C201256) [_ O] x|

Contract: [C201256 M Contractor: APAC - ATLANMTIC, INC. THOMPSON ARTH  Status: Activated
Description (hickhame): SEDGE GARDEMN 2006
|HP12X53 PILES v| UOM: Linear Feet

Line Received
Item Material UOM  Quantity | Received By

Line Item:

Plant
Status

3 es -w Huffman, Terry L BXSS19 | Transfe
2 ﬁlmli P 12 X 53 Steel Piles [ 53.347 Byrd, Barry R 5569 Transfer
3 | [pa/17/2006 29 HP 12 % 53 Steel Piles LF 127 953 Byrd, Barry R 5559 Transfer
4 | [p4/17/2006 |28 HP 12 53 Steel Piles LF | 39.662 Byrd, Barry R [F588  Transfer
5 | [na/o9/2006 [29 HP 12 % 53 Steel Piles LF 240.000 Huffran, Terry L [S519 Transfer

General | Cerification Alternate 1D lHlstory I

Line Item: 29 - HP1Z2+53 PILES Unit Price: $48.8500
Bid Quantity: 375.000 Date Produced: [00/00/0000  [ig]|
Approved Producer/Supplier: [Skyline Steel Corp., Skyline Steel Corp. - Duluth, GA - SS19|@ Concrete Mix:
Other Producer/Supplier: | @ [] small Quantity
Brand Name: | @
How Accepted: Certification Transferred From: C200591
Comment: @

Feady

Notice that all the fields are filled in except for the MRR number. The Received By fields
are the names of the original inspector who received the Material, and the dates are the
original date the material arrived on the source project.

The Material Receipt record has a status of Transfer until it is updated with a Material
Receipt Number in HICAMS.

Possible Error:

The Line Item assigned to the Transferred Material will be that of the first
Line Item that has this Material on its Contract BOM. If the Material exists
on more than one Line Item on the Contract BOM, type in the correct Line
Item number when you are updating the other fields on the MRR.

When the Material arrives on the destination project, an Inspector on that project will
create an MRR. Frequently, a Materials Transferred form M&T Form 255 will have been
sent by the transferring Resident Engineer's office. It should be attached to the new
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Material Receipt. The data on the MRR should be verified against the data on the
transfer records, and the new MRR number entered.

Here is what the completed Transferred Material Receipt record looks like:

#ry HICAMS - [Hicamsprod]

- [= 1]
File Edit Functions Inguiries References Admin  Tools Window Help
[=mmess ne? s kadE
4 Review Material Receipts {C201256) [_ O] x|

Contract: ICQD1256 ﬂ Contractor: APAC - ATLANMTIC, INC. THOMPSON ARTH  Status: Activated
Description (nickname): SEDGE GARDEM 2006

Line Item: |25 |HP12x33 PILES v| UOM: Linear Feet

Line Received Plant
Row MRR Date Item Material Jyom Quantity Received By 1D Status |
0524/2005 [25____ [P 12x 53 [ 89 00gfruriman, Tery L [EYss19 ||

HP 12 Steel Piles Y erry g Received
2 [rs [P 12x53SteeiPies  LF | 53347 Byrd, BaryR 5559 Received
3 |?-s |D4f1 7/2006 |29 |HF' 12 ¥ 53 Steel Piles LF | 127 953 Byrd, Barry R 5559 Received
4 [75 [p4717/2006 |28 [HP 12X &3 Steel Piles LF 39.662 Byrd, Barry R [F588  Received
5 [-5 [p3/09/2008 o3 |HP 12 53 Steel Piles LF | 240.000 Huffman, Terry L E=RE] Received

General | Certification | Alternate D History |

‘ Action Action Date Status Who Comment |
Create 06/09/2006 8:24:00 AM Received Myers, Dana C
|Rieady

Remember

1. Materials must be on the Contract Bill of Materials in order to appear in the drop
down Materials list.

2. Inserting a new row will use the current conversion factor and MSG. A Save As will
use the conversion factor and MSG of the original record.
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Window Definitions - Review Material Receipts

To work with the Review Material Receipts window, go to Functions > Contract
Tracking > Review Material Receipts. Enter the Contract Number whose Material
Receipts you wish to review in the Contract field.

Note: For information on ways to enter your contract number, see the
User Guide "Getting Started" in the User Guides section of the HICAMS
home page.

Below is an example of the Review Material Receipts window for contract C201562
after selecting (All) Line Items.

##y HICAMS - [Hicamsprod] [_[5]x]

File Edit Functions Inguities References Admin Tools ‘Window Help
|[=nwe st #e? s kb

# Review Material Receipts (C201562) =] E3

Contract: ICQD1562 @ Contractor: BALFOUR EEATTY CONSTRUCTION INC Status: Activated

Description (hickname): Bridge - Stadium Drive - Wake Forest

Line Item:| |(AH) x| uom:

Line Received Plant
Row MRR Date Item Material VoM  Quantity | ReceivedBy Status

Concrete Units m Benrett, R ’1rrnrr|

2 ﬁ'm'im EA | 1.000 Bennett, Ransom W Received
3 |2 |D4f28f2006 |1D |Ind|V|duaI Castings Companents  EA | 1.000 Bennett, Ransam CI2 Received
4 2 [p4r28/2008 |11 nividual Castings Components EA | 1.000 Bennett, Ransam CI2 Received
5 |4 |D§f04f2006 |2D |Engineering Fabric, Type Il (Unde S | 344.000 Bennett, Ransom li Received
6 6 [pa/17/2008 24 [Concrete, Drilled Pier cy 24 000 Bennett, Ransom RM2189 Received
EANE [psr11/2008 [27 |HF 12 X 53 Steel Piles LF | 550.000 Bennett, Ransom  [3516 Received
8 5 [pa/17/2008 o3 [Reinfarcing Steel, Plain s | 7,734.000 Bennett, Ransom [ Received
=l
General |Cenificatian |AIternateID | Histary |
Line Item: 9 - MASNRY DRAINAGE STRUCT Unit Price: $1,950.0000
Bid Quantity: 2.000 Date Produced: [IiINANAN  [ig)
Approved Producer/Supplier: |Car0|ina Precast Concrete Co., Inc., Caroling Precast, Inc. - 1ﬂ Concrete Mix:
Other Producer/Supplier: | @l [] small Quantity
Brand Name:| @l
How Accepted: FIR-Pretest (Alt Req) Transferred From:
Comment: @I

|Ready

Note: The default Sort Order is Line Item number first, then the Date
(newest first), MRR number, and Material. The default Sort Order can be
changed by clicking on the Sort icon or by selecting Edit > Sort. See the
User Guide "Getting Started” for more details on working with the Sort
function.
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Column Definitions for the Review Material Receipts Window

Row: A number assigned by HICAMS. Used to identify those rows which cannot be
saved.

MRR: The number assigned by the Resident Engineer's Office to each Report of
Material Received (MRR) turned into the office. This field may currently contain any
combination of numbers and text.

Date: The date on the MRR. This may or may not correspond to the date that Material
was received on the project. It generally is not before the date the material arrived at the
project.

Line Item: The Line Item associated with the Material on the MRR. The same material
may occur on one or more Line Items on the Contract Bill of Materials (CBOM). The
Line Item must be entered before any Materials associated with the Line Item will
display.

Material: If only one Material is associated with a Line Item, it will default in the Material
field. If more than one material received by MRR exists on the CBOM, the user must
select the Material from the drop down list.

UOM: UOM stands for Unit of Measure. This is the unit of measure associated with the
Material. It may or may not be the same as the Line Item Unit of Measure.

Received Quantity: The quantity of Material received at the project.
Received By: The name of the individual who created the paper MRR.

Plant ID: The unique alphanumeric combination which is assigned to a Producer
Supplier. The first two characters identify the Facility Type and the next one or more
characters are the Facility's unique number.

Note: For a complete listing of all Facility Types and their associated two-
letter code, see DOH Vendor > Admin > Codes Table > Facility Type.

Status: There are three Material Receipt Report statuses.

Received: Indicates that the Material has been accepted on the project and is
counted for Project Acceptance purposes

Transfer: Indicates that the Material has been transferred from another project
and a skeleton MRR entry has been created in HICAMS. See the section entitled
"XXX" of this User Guide for more information on Transferring materials in
HICAMS.

Void: Indicates that the Material on the MRR is no longer counted for Project
Acceptance purposes.
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Field Definitions for the Review Material Receipt Window Tabs
General Tab (Active for all Material Receipts):

Ge
Line Item: 29 - HP12X53 PILES Unit Price: $45.8500
Bid Quantity: 375.000 Date Pr°duced=IWE|
Approved Producer/Supplier: |SKyIinE Steel Corp., Skyline Steel Corp. - Duluth, GA - 8819|ﬂ Concrete Mix:
Other ProducerfSupplier:| @l [] small Quantity
Brand Name: |
How Accepted: Certification Transferred From: C200591
Comment: RECEINVED BY SIZEMORE @I

gl

|Ready

Line Item: The Contract Line Item number and Description. May include contract

adjustment information.

Unit Price: The Bid Item's Bid Price

Bid Quantity: The estimated amount of work included in the contract for this Line

Item.

Date Produced: When the Material was fabricated.

Approved Producer Supplier: If the MSG Material Type being received has a

Facility Type required, the facility is selected here.

Concrete Mix: If the MSG Material Type being received requires a Concrete Mix

design, the CMD is selected here.

Other Producer Supplier: If the MSG Material Type being received does not have

a Facility Type required, the producer's name is typed here.

Small Quantity: Checking this box overrides the MSG settings if the MSG allows

special consideration for small quantities of material.

Brand Name: A name used to identify a commercial product or service, which
may or may not be registered as a trademark. If the MSG Material Type being
received requires that the Material be on an Approved List, the material's brand

name is typed here.

How Accepted: Displays the MSG requirements that will generate an accepted

guantity.

Transferred From: Displays the source contract on a MRR created using the

Transfer function.

Comment: Provides a space to enter additional information about the MRR entry.
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Certification Tab (Active for Materials which require Certifications)

General  Certification |AIternateID |History |

Cert Type(s): [I: Certified Mill Test Report

[ Certified Test Reports

|
[2: Typical Certified Mill Test Repart |
|
|

Approval Resp: |F'r0ject Personnel

Approved Date: IDSIDAIQDDG M Deocuments Received

Approved By: [Bennett, Ransom B |ﬁ|

|Feady

Cert Types: Lists the Types of Certifications required by the MSG for this Material
Type.
Note: Certification Types are defined in Section 106-3 of the

NCDOT Standard Specifications for Roads and Structures. For
additional information, contact the Materials and Tests Unit.

Approval Resp: Indicates who is responsible for reviewing and accepting each
Certification

Approved Date: The date the certifications were reviewed for acceptance.

Documents Received: Checking this box indicates that the required certifications
have been submitted with the Material Received Report.

Approved By: The name of the person who reviewed the certifications for
acceptance.

Alternate ID Tab (Active for Materials which require Alternate IDs)

General | Cetification  Alternate 1D |History |

Alternate Received Accepted Sample | FIR Report FIR Report
Row Type Alternate ID Quantity Quantity 1D Type 1D

oo g wosa | By |

Define Range
Count|? =1

I Ea|

Create Range |
Clear Range |

|Ready
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Alternate Type: The Type of Alternate ID required by the MSG for this Material
Type.

Note: For assistance with Alternate IDs, contact Materials and
Tests HICAMS Support at 1-919-329-4357.

Alternate 1D: The number that links the Material on the MRR to a Sample or Field
Inspection Report.

Received Qty: The amount of the Material that has this Alternate ID. Some
Alternate Types are specific to each Piece and will have a quantity of 1 while
some can represent Lots and can have a quantity greater than 1.

Accepted Quantity: The quantity available on the Sample or FIR that can be
linked to this MRR. This quantity may be less than or equal to the Received
Quantity.

Sample ID: The number of the Sample to which the Alternate ID is assigned. If
this field is populated, the FIR Report Type and FIR Report ID will be blank.

FIR Report Type: The Name of the Field Inspection Report to which the Alternate
ID is assigned.

FIR Report ID: The number of the Field Inspection Report to which the Alternate
ID is assigned. If the FIR Report Type and Report ID fields are populated, the
Sample ID will be blank.

Note: The Sample or Field Inspection Report information is only
populated if the Alternate ID Matching setting on the Minimum
Sampling Guide is set to Match Alt ID/Match from Sample.

History Tab (Active for all Material Receipts):

General | Certification |AItemateID History |

Acticn Action Date Status Whe Comment | ‘
Create 01/06/20038 2:24:00 PM Received Wilsan, Kathy H %
Transfer 02/12/2009 10:10:00 AW Received Wilsan, Kathy H A total guantity of 108.200 fram this MRR has been transferred to Cor

|Ready

Action: Shows what was done to the Material Receipt. Actions include Comment,
Conversion, Create, Transfer, and Void.
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Action Date: The date that the action was set in HICAMS. This date and time are
system generated.

Status: Indicates whether the Material Receipt is Received, Voided, or
Transferred.

Who: The display name of the person who took the action.
Comment: Displays the most recent comment made for this Material Receipt.

Provides tracking information for who did what and when it was done

Navigation Button Definitions
The following buttons appear in the toolbar of the Review Material Receipts window.

Please note: Buttons will display in the window based on the status of the highlighted
row in the window.

| Insert button. Used to create a New Row.

2 Delete button. Used to remove an UNSAVED row.

& Save As button. Used to create a copy of an existing row.

E Void button. Used to nullify a SAVED row.

i Transfer button. Used to move the electronic record for a material from one project
to another.
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